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Typographic Conventions

Table 1

oomie o

<Example>

Angle brackets indicate that you replace these words or characters with appropriate entries
to make entries in the system, for example, “Enter your <User Name>".

b Example » Example 3

Arrows separating the parts of a navigation path, for example, menu options

Example

Emphasized words or expressions

Example

Words or characters that you enter in the system exactly as they appear in the
documentation

WWW.Sap.com e

Textual cross-references to an internet address

/example Quicklinks added to the internet address of a homepage to enable quick access to specific
content on the Web
123456 A Hyperlink to an SAP Note, for example, SAP Note 123456
Example ®  Words or characters quoted from the screen. These include field labels, screen titles,
pushbutton labels, menu names, and menu options.
®  Cross-references to other documentation or published works
Example ®  Qutput on the screen following a user action, for example, messages
®  Source code or syntax quoted directly from a program
® File and directory names and their paths, names of variables and parameters, and
names of installation, upgrade, and database tools
EXAMPLE Technical names of system objects. These include report names, program names,

transaction codes, database table names, and key concepts of a programming language
when they are surrounded by body text, for example, SELECT and INCLUDE

Keys on the keyboard
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Document History

A Caution

Before you start the implementation, make sure you have the latest version of this document. You can find the
latest version at service.sap.com/instguides # .

The following table provides an overview of the most important document changes.

Table 2
1.0 2015-05-28 Initial Version
11 2015-11-12 Formal revision for SPO2
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1 Getting Started

Caution

This guide does not replace the daily operations handbook that we recommend customers create for their
specific production operations.

Designing, implementing, and running your SAP applications at peak performance 24 hours a day has never been
more vital for your business success than now.

This guide provides a starting point for managing your SAP applications and maintaining and running them
optimally. It contains specific information for various tasks and lists the tools that you can use to implement them.
This guide also provides references to the documentation required for these tasks, so you need other guides such
as the Master Guide, Technical Infrastructure Guide, and SAP Library.

1 Note

For more information about the various tasks that you can carry out and tools that you can use for SAP Event
Management, see the Application Operations Guide for SAP Event Management on SAP Service Marketplace at

service.sap.com/instguides # .

11 Global Definitions

SAP Application:

An SAP application is an SAP software solution that serves a specific business area such as ERP, CRM, PLM, SRM,
or SCM.

Business Scenario:

From a microeconomic perspective, a business scenario is a cycle that consists of several different
interconnected logical processes in time. Typically, a business scenario includes several company departments
and involves other business partners. From a technical point of view, a business scenario needs at least one SAP
application (for example, SAP ERP or SAP SCM) for each cycle and possibly other third-party systems. A business
scenario is a unit that can be implemented separately and reflects the customer’s prospective course of business.

Component:

A component is the smallest individual unit considered within the Solution Development Lifecycle; components
are separately produced, delivered, installed, and maintained.
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1.2 Important SAP Notes

= Recommendation

Check regularly for updates to the Application Operations Guide.

Table 3: Important SAP Notes — Installation/Upgrade Notes

1678998 A Release Strategy for the ABAP Add-On | None
SAPTM

2159217 Release Restrictions of SAP None
Transportation Management 9.3

2127323 A Installation/Delta Upgrade note for TM | None
9.3 on NETWEAVER 740

1539802 SAPTM: Overview note None

2127348 e Implementing the SCM Optimizer None
Version 12.0

2118104 A Installation/Upgrade SCEMSRV 920 None

1224284 A Enterprise Services, Installing and None
Accessing the SOA Documentation.
This SAP Note lists the business-related
grouping of Enterprise Services.

1515223 A SAP NetWeaver Process Integration: None
Release Recommendation. This SAP
Note sets out our recommendation on
which release of SAP NetWeaver Pl you
should use.

1529649 A Factory Calendar Expires 2010 None

1388258 A Version Interoperability within the SAP | None
Business Suite

1573180 AEX Enablement for SAP Business Suite | None

1846034 SAP Visual Business 2.1: Information None
about patches

1738013 A TM: Integration with ERP Enhancement | None

1747234 A Trigger Processing and Usage of the None
Report /SCMTMS/
PROCESS_TRIGGER_BGD
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Table 4: Important SAP Notes — Information/Consulting Notes

‘ 900000 v

‘ NetWeaver Business Client - FAQ

‘ None

Table 5: Important SAP Notes — Troubleshooting Notes

423184 A ALE: Problems with Logical System None
Names

1080668 Problems with alert subscription None

1634677 A TM: Checking Customizing settings in None
ERP
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2 Technical System Landscape

2.1 Scenario/Component Matrix

The following table lists the components that are available for each scenario:

Table 6
Scenario SAP TM SAP ERP SAP EM SAP SAP VB T&L
Optimizer Collaboratio
n Portal

International | X X X X ] X Not

Inbound applicable

Logistics (lIL)

Domestic X X X X O X 0

Outbound

Transportatio

n (DOT)

LCL Ocean X X Not X 0] X Not

Freight (OF) applicable applicable

Airfreight X X Not X O X Not
applicable applicable

Intermodal X X X X 0] X Not

Rail Freight applicable

Courier X X X X O X Not

Express applicable

Parcel

Scenario component key: X = mandatory, O = optional, Not applicable = not part of the business process

For more information about the components necessary for the business processes for SAP Transportation
Management 9.3 (SAP TM 9.3), see the Master Guide for SAP Transportation Management on SAP Service

Marketplace at |p service.sap.com/instguides i » SAP Business Suite Applications » SAP TM » Using SAP TM
931

2.11 SAP NetWeaver 7.4

SAP NetWeaver 7.4 is the integration and application platform for SAP TM 9.3. The following SAP NetWeaver
components are part of the infrastructure:

o SAP Web Application Server (ABAP) 7.4
e SAP Web Application Server (Java) 7.4 (for printing purposes)
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®  SAP NetWeaver Exchange Infrastructure (XI)
e SAP NetWeaver Bl (Business Intelligence) 7.4
® SAP NetWeaver Business Client 4.0

e SAP Gateway
e SAP UI5 Client Runtime

212

For information about installing and setting up SAP SCM Optimizer, see the Installation Guide for Windows or
Linux. The guides are located on SAP Service Marketplace at |p service.sap.com/instguides s » SAP Business

SAP SCM Optimizer

Suite Applications » SAP Transportation Management » SAP SCM Optimizer 1.

2.1.3 SAP Internet Graphics Service

The Internet Graphics Service (IGS) is part of SAP NetWeaver and can be used in SAP TM 9.3 to support the

display of graphics and to integrate GIS data.

2.2 Related Documentation

The following table lists locations in which you can find more information about the technical system landscape.

Table 7

Guide/Tool Quick Link on SAP Service Marketplace

Application-specific and Master Guide b service.sap.com/instguides # 3
industry-specific components

such as SAP Financials and SAP

Retail

Technology components such Master Guide

as SAP Web Application Server

|# service.sap.com/instguides # 3

SAP SCM Optimizer

Installation Guide

|» service.sap.com/instguides # 3

Sizing

Quick Sizer Tool

| service.sap.com/sizing # 1

Technical configuration

Technical Infrastructure Guide

|p service.sap.com/installNW70 # 3

Scalability

Technical Infrastructure Guide

|# service.sap.com/instalNW70 # 3

High Availability

Technical Infrastructure Guide

|p service.sap.com/installNW70 # 3
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Guide/Tool Quick Link on SAP Service Marketplace

Security Technical Infrastructure Guide b service.sap.com/instalNW70 # 3

|» service.sap.com/security # 3
SAP Event Management Application Operations Guide I service.sap.com/instguides # 3
SAP Transport Tendering Administrator's Guide [k service.sap.com/instguides # 3
mobile app

SAP Transport Notification and
Status mobile app

Administrator's Guide

| service.sap.com/instguides # 3

T&L Collaboration Portal

Administrator's Guide

|F service.sap.com/instguides # 3

SAP NetWeaver Gateway

Application Operations Guide

| service.sap.com/instguides # » SAP
NetWeaver » SAP NetWeaver Gateway 3
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3 Monitoring of SAP Transportation
Management

Within the management of SAP Technology, monitoring is an essential task. A section has therefore been devoted
solely to this subject.

For more information about the underlying technology, see the SAP Library for SAP NetWeaver 7.4 at

help.sap.com/nw . In SAP Library, choose |» SAP NetWeaver Library: Function-Oriented View » Application
Server » Application Server ABAP » Monitoring and Administration Tools for Application Server ABAP Jor | SAP
NetWeaver Library: Function-Oriented View » Application Server » Application Server Java » Administering
Application Server Java » Monitoring 3.

3.1 Alert Monitoring with CCMS

Proactive, automated monitoring is the basis for ensuring reliable operations for your SAP system environment.
We provide you with the infrastructure and recommendations needed to set up your alert monitoring to recognize
critical situations for SAP TM 9.3 as quickly as possible. SAP TM 9.3 uses the Computer Center Management
System (CCMS) for alert monitoring.

3.1.1 CCMS Monitoring Installation and Setup

The Computer Center Management System (CCMS) provides a range of monitors for SAP environments and their
components. These monitors are essential for understanding and evaluating the behavior of the SAP processing
environment. In the case of poor performance values, the monitors provide you with the information required to
fine tune your SAP system and therefore to ensure that your SAP installation is running efficiently.

For more information about installing and setting up the CCMS, see [F service.sap.com/instguides # » SAP
NetWeaver 1.

To enable the auto-alert mechanism of CCMS, see SAP Note 617547 ¢ .

3.1.2 Component-Specific Alert Monitoring

The following components are part of SAP TM 9.3:

® SAP NetWeaver 7.4

® SAP Business Suite Foundation 7.47 (BS_FND 747)
e SAP SCM Basis 7.13 (SCM_BASIS 7.13)

® SAP Transportation Management 9.3 (SAP TM 9.3)

CUSTOMER
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e SAP SCM Optimizer 12.0

3.1.2.1 SAP NetWeaver 7.4

For information and detailed procedures related to SAP NetWeaver 7.4 alert monitoring, see the Monitoring Setup

Guide for SAP NetWeaver at service.sap.com/operationsNW74 # and the Technical Operations Manual for SAP
NetWeaver in SAP Library under [ SAP NetWeaver » SAP NetWeaver 7.4 » SAP NetWeaver Library: Function-
Oriented View » Application Server » Application Server ABAP » Administration of Application Server ABAP »
Monitoring and Administration Tools for Application Server ABAP 1.

3.1.2.2 SAP SCM Basis 7.0 Including Enhancement Package
3

SAP SCM Basis including enhancement package 2 enables monitoring of SAP Core Interface (CIF) and gRFC-
related values such as an overview of blocked gRFCs. You can start the monitor from the user menu by choosing
|» SCM Basis » Integration » CCMS Monitor Sets {1 (transaction Rz20). For more information about setting up this

monitor, see SAP Library for SAP Supply Chain Management on SAP Help Portal at help.sap.com/scm#. In SAP
Library for SAP Enhancement Package 3 for SAP SCM 7.0, choose |» SCM Basis » Alert Monitor 1.

3.1.2.3 SAP Transportation Management 9.3

For more information about monitoring SAP TM 9.3 using the Computer Center Management System (CCMS)
alert monitor (transaction rRz20), see SAP Library for SAP NetWeaver 7.4 at help.sap.com/nw . In SAP Library,
choose |F SAP NetWeaver » Administration Information » Technical Operations for SAP NetWeaver » Technical
Operations for Search and Operational Analytics » Monitoring » Alert Monitoring with CCMS 1.

3.1.2.4 SAP SCM Optimizer 12

For more information about installing and setting up SAP SCM Optimizer, see the Installation Guide for SAP SCM
Optimizer . The guides are located on SAP Service Marketplace at [F service.sap.com/instguides s » SAP
Business Suite Applications » SAP Transportation Management » SAP SCM Optimizer 1. To monitor the
availability of SAP SCM Optimizer, follow the instructions in SAP Note 762183 #e.
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3.1.2.5 Internet Graphics Service

The IGS can be monitored with CCMS, which provides an overview of the current IGS configuration, the port
watchers available, and their associated interpreters. It also displays various performance values for the relevant
IGS components.

To monitor IGS in the CCMS, you must activate CCMS Monitoring. You can do this by starting report
GRAPHICS IGS_ ADMIN intransaction SE38. Enter IGS RFC-Destination and press . Then select the
Environment menu and choose Switch on CCMS.

You can find the monitor tree for IGS in the CCMS (transaction RZ20) as the Internet Graphics Server in the
monitor set SAP CCMS Monitors for Optional Components. For more information about the values displayed in
the CCMS, see SAP Library for SAP NetWeaver at help.sap.com/nw # . In SAP Library for SAP NetWeaver 7.4,
choose | SAP NetWeaver Library: Function-Oriented View » Application Server » Application Server ABAP » Ul
Technologies in ABAP » Further Ul Technologies » SAP Graphics » Administering the Internet Graphics Service
(IGS) =

3.2 Detailed Monitoring and Tools for Problem and
Performance Analysis

SAP TM 9.3is based on Web AS 7.4 (part of SAP NetWeaver 7.4).

For more information about technical problem analysis (such as with a database, the operating system, or
workload analysis), see SAP Library for SAP NetWeaver at help.sap.com/nw #. In SAP Library for SAP
NetWeaver 7.4, choose |» SAP NetWeaver » Administration Information » Technical Operations for SAP

NetWeaver 1. This guide covers only the differences and additional information specific to SAP Transportation
Management.

3.2.1 SAP Transportation Management 9.3 Analysis Tools

3.2.11 Trace and Log Files

Trace files and log files are essential for analyzing problems. The standard SAP NetWeaver tools such as
transactions sT22 and sM21 can be used to monitor trace and log files. For more information, see SAP Library for

SAP NetWeaver at help.sap.com/nw . In SAP Library for SAP NetWeaver 7.4, choose |» SAP NetWeaver Library:
Function-Oriented View » Application Server » Application Server ABAP » Administration of Application Server
ABAP » Monitoring and Administration Tools for Application Server ABAP 1.

SAP TM 9.3 uses the application log (part of SAP NetWeaver) to store error, warning, and success messages
issued in critical processes or in Ul transactions. For Ul transactions, the application log has to be saved explicitly
by the user.

For general information about application logs, see SAP Library for SAP NetWeaver at help.sap.com/nw A . In
SAP Library for SAP NetWeaver 7.4, choose [ SAP NetWeaver: Function-Oriented View » Solution Life Cycle
Management » Application Log — (BC-SRV-BAL) 1.

The following application logs can be monitored with transaction ST.G1:
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e /scMTMS/TMS (Transportation Management)
e ppr (Post Processing Framework)

For a description of the tasks recommended for containing data growth, see Periodic Tasks [page 29].

3.21.2 Interface Monitors

Interface monitors are essential for analyzing problems with interfaces such as RFC, IDoc, and HTTP.

SAP TM 9.3 uses the standard tools available in the SAP Web Application Server 7.4, and does not require an
application-specific tool. For more information, see the Technical Operations Manual for SAP NetWeaver.

SAP Transportation Management uses standard tools to monitor the Xl interfaces. Use transaction SXxI MONITOR
to monitor Xl interfaces.

3.21.3 Workload Monitors

SAP Transportation Management uses the standard tools available in SAP Web Application Server 7.4 and does
not require an application-specific tool. For more information, see SAP Library for SAP NetWeaver at
help.sap.com/nw # . In SAP Library for SAP NetWeaver 7.4, choose |» SAP NetWeaver » Administration
Information » Technical Operations for SAP NetWeaver 1.

3.2.1.4 Database Monitors

SAP Transportation Management uses the standard tools available in SAP Web Application Server 7.4 and does
not require an application-specific tool.

For more information, see SAP Library for SAP NetWeaver at help.sap.com/nw # . In SAP Library for SAP
NetWeaver 7.4, choose |» SAP NetWeaver » Administration Information » Technical Operations for SAP
NetWeaver 1.

3.2.15 Operating System Monitors

SAP Transportation Management uses the standard tools available for SAP Web Application Server 7.4 and does
not require an application-specific tool.

For more information, see SAP Library for SAP NetWeaver at help.sap.com/nw A . In SAP Library for SAP
NetWeaver 7.4, choose |» SAP NetWeaver » Administration Information » Technical Operations for SAP
NetWeaver 1.

For more information about the Operating System Collector (OS Collector), see SAP Library under the
component Operating System Monitor.
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3.2.2 SAP SCM Optimizer Analysis Tools

Once SAP SCM Optimizer has been correctly installed and configured, the following monitors and transactions
can be used for administration, analysis, and maintenance.

3.2.21

Administration Tools

Table 8
Monitoring Object | Monitor Monitor Indicator or Error | Monitoring Responsibility
Transaction / Frequency Activity or Error
Tool Handling
Procedure
User list for rcc_session As required Not applicable Displays a user list | Basis Support
optimizers for optimizers
Versions of rcc_version As required Not applicable Displays optimizer | System monitoring
optimizers versions team
Running optimizer | rcc session As required Not applicable Display optimizer | Basis Support
processes processes
RFC destinations | SM59 / During installation | Test connection Defining and System monitoring
for optimizers rcc_cust or after status to ensure all | checking optimizer | team and Basis
configuration is OK RFC destinations — | Support
changes can also be used to
check if optimizer
server is online
Spool file of SM37 As required Messages in spool | Check also for Application
optimizer run file application errors | Support / Job

after the optimizer
run using
rcc_log(see
section Trace and
Log

Files [page 17]).

scheduling team

3.2.2.2 Trace and Log Files

Trace files and log files are essential for analyzing problems.

SAP™ Transportation Management

Monitoring of SAP Tr.

tation M it
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Table 9: Important Trace and Log Files

Monitoring
Object

Optimizer logs
and trace files

Monitor
Transaction /
Tool

rcc _log

To display the
trace files,
choose

| Extras »
Display Log
File 3.

Monitor
Frequency

Check frequently
— daily, weekly

Indicator or
Error

Check for Errors

Monitoring Activity or
Error Handling Procedure

Display and analyze
optimizer logs and trace
files.

These files are on the
server in the directory 1og
of the SAP gateway on
which the optimizers are
installed (either own server
or application, or database
server):

Directory (Windows
version):
\usr\sap\<SID>
\G<GWNr>\1logor\usr
\sap\<SID>
\DVEBMGS<GWNr>\1log

<SID> = SystemID

<GWNr> = SystemNr
(=GatewayNr) for
example00

For more information, see

SAP Note 391808 .

Responsibility

Basis Support

Changing the
detail level of
trace files

/SCMTMS /
WDC TS ENG C
OMF

Check frequently
— daily, weekly

Check for Errors

|+ System Administration »
Remote Control X and

I Communication
Framework » Settings ¥
Engine Debug
Configuration 3

Basis Support

Spool file of
optimizer run

SM37

As required

Messages in
spool file

Check also for application
errors after the optimizer
runusing rcc_log (see

above).

Application
Support / Job
scheduling team

3.2.3 SAP Business Information Warehouse

SAP Business Information Warehouse (SAP BW) is optional. User navigation data from interactive scripting is
exported to SAP BW for analysis.
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3.2.4 Transportation and Logistics Collaboration Portal
Analysis Tools

3.2.4.1 Back-End Error Messages

Back-end error messages are saved in the Netweaver Gateway system. To access these error messages, perform
the following steps:

1. Runtransaction /IWFND/ERROR LOG
2. Select the log entry, and choose Error Context
3. Choose Application Log

Note down the error number of each message with the message text: This is an external message.
Access message text via details

4. Toview the text of each external error message, choose Detail Exists

3.2.4.2 Front-End Error Messages

Front-end error messages are displayed in the message bar at the bottom of the screen. There can be instances in
which no front-end error messages are displayed but the application is not responding as expected. In these
instances, the browser console can contain the error messages. To access these messages on the browser,
perform the following steps:

1. Openthe developer tools of the browser

2. Gotothe Console tab page
To access these messages on the Apple iPad, perform the following steps:
1. Connect the Apple iPad to an Apple MacBook

2. Activate the Web Inspector on the iOS operating system

3. Open the Safari browser and connect to the Apple iPad

4. Goto Console tab page

For more information about accessing messages on the Apple Ipad, see developer.apple.com/library/safari/
#documentation/appleapplications/reference/safariwebcontent/DebuggingSafarioniPhoneContent/

DebuggingSafarioniPhoneContent.html#//apple_ref/doc/uid/TP40006515-SW1 #

3.2.4.3 Cache Clean-Up

Caches are used in the portal to achieve reasonable performance. These caches include the browser cache and
the Ul source code cache. When you change the source code due to modifications, implementation of notes or
updates, we recommended that you clean up the caches.

To clean the Ul source code cache, perform the following steps :
1. Inthe browser, enter <Portal URL>/resetcachebuster

2. Enteruser and password

CUSTOMER
SAP™ Transportation Management © Copyright 2015 SAP SE or an SAP affiliate company.
Monitoring of SAP Transportation Management All rights reserved. 19


http://help.sap.com/disclaimer?site=http%3A%2F%2Fdeveloper.apple.com%2Flibrary%2Fsafari%2F%23documentation%2Fappleapplications%2Freference%2Fsafariwebcontent%2FDebuggingSafarioniPhoneContent%2FDebuggingSafarioniPhoneContent.html%23%2F%2Fapple_ref%2Fdoc%2Fuid%2FTP40006515-SW1
http://help.sap.com/disclaimer?site=http%3A%2F%2Fdeveloper.apple.com%2Flibrary%2Fsafari%2F%23documentation%2Fappleapplications%2Freference%2Fsafariwebcontent%2FDebuggingSafarioniPhoneContent%2FDebuggingSafarioniPhoneContent.html%23%2F%2Fapple_ref%2Fdoc%2Fuid%2FTP40006515-SW1
http://help.sap.com/disclaimer?site=http%3A%2F%2Fdeveloper.apple.com%2Flibrary%2Fsafari%2F%23documentation%2Fappleapplications%2Freference%2Fsafariwebcontent%2FDebuggingSafarioniPhoneContent%2FDebuggingSafarioniPhoneContent.html%23%2F%2Fapple_ref%2Fdoc%2Fuid%2FTP40006515-SW1

If the cache is cleaned, the system displays the message: Cachebuster for SAPUI5 application "/

tmui/coll portal" has been reset
To clean the browser cache, perform the following steps:
®  Microsoft Internet Explorer
Go to |k Settings » Developer Tools (F12) » Cache 1
. Choose Clear Browser Cache.
® (Google Chrome
Go tolk Menu » Tools » Clear Browsing Data 3
. Select Empty the cache and choose Clear Browsing Data.
® Mozilla Firefox
Go to |k Options » Advanced » Network » Cached Web Content 3
. Choose Clear Now.
e Safarion Apple Ipad
Go to | Settings » Safari 1

. Choose Clear Cookies and Data.

3.3 Data Consistency

If you store related or identical data in multiple places, inconsistencies may occur (for example, after you restore a
single component). The following information describes how you can verify consistency and resolve
inconsistencies.

SAP TM 9.3 uses standard tools available in SAP Web Application Server 7.4, and does not require an application-
specific tool.

For more information, see SAP Library for SAP NetWeaver at help.sap.com/nw #. In SAP Library for SAP
NetWeaver 7.4, choose |» SAP NetWeaver » Administration Information » Technical Operations for SAP
NetWeaver 1.

SAP TM exchanges data with SAP ERP using asynchronous messages. If such a message exchange fails, you can
re-send messages. Cases of data inconsistency do not, therefore, apply here. For more information about tools
for checking message exchange errors, see Monitoring of SAP Transportation Management 9.3 [page 13].

Internal Data Consistency

Internal data consistency describes the correctness of master data and transactional data that you create,
change, or delete in the SAP TM application.

Master Data

Master data for SAP TM is located in different software layers, for example SAP TM and SCM Basis. When the
system processes master data objects in transactions or automated functions, it ensures consistency by using
standard checking procedures. Transactions can identify inconsistent master data objects, and the system
displays error messages on-screen and in the application log. You must create an error message for SAP support
to check and resolve these errors. A system breakdown does not create master data inconsistencies because the
system can only commit consistent data.

Transactional Data

Transactional data for SAP TMis located in the SAP TM software layer. The same rules apply for transactional
data consistency as for master data.
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Available Tools

No tools specific to SAP TM are required to check data consistency.

External Data Consistency

Implementing an SAP TM system in your system landscape increases the demand on your interface management
and system administration by increasing data exchange between systems. In particular, you create a close
connection between the SAP ERP systems and SAP TM. Correct, consistent, and current data is a prerequisite for
successful planning activities in SAP TM.

Causes of External Data Inconsistency

You can have data inconsistency between systems if one or more of the following events occur:

® |ncomplete recovery in one of the systems in the system group

® Manual change of data in SAP ERP or SAP TM

® Programerrors

® |ncorrectintervention in the core interface (CIF), for example, if you delete orders without transferring them
to SAPTM

We provide standard tools for checking internal and external consistency. How you use these tools depends on
the scenario you implement in SAP TM. We recommend that you run CIF post processing after you complete
internal consistency checks and before you start external consistency checks. If more than one SAP ERP system
is connected to an SAP TM system, you must use the corresponding tool for each of these SAP ERP systems and
the SAP TM system.

SAP Transportation Management — SAP Optimizer
Since the SAP Optimizer is a stateless engine, we do not expect you to encounter any data inconsistencies

between SAP TM and the SAP Optimizer. If the SAP Optimizer crashes during a planning run, SAP TM does not
receive optimization results and therefore cannot save inconsistent data.

We also do not expect inconsistent business documents to occur for packaged processing. It may happen that
you can commit a certain data package successfully, while the next commit fails. This creates a number of
successfully planned business documents and a number of unprocessed business documents. You can start the
required business transaction for the unprocessed documents again.

SAP TM informs you if the SAP Optimizer is not available when you start a planning run. We recommend that you
monitor the availability of the SAP Optimizer closely. You can restart failed optimization runs when the SAP
Optimizer is running again.

For more details, see the Application Operations Guide for the SAP Optimizer.

SAP Transportation Management — OLTP

In a system setup that includes SAP TM and an online transaction processing (OLTP) system such as SAP ERP, it
is important to ensure data consistency between the systems. Due to the close link between the systems and the
business impact of a system breakdown, we recommend that you closely monitor the inbound and outbound
queues, system availability, and application logs of all the systems involved so that you can react quickly.

If you have a system breakdown, none of the systems internally commits inconsistent data. If such an error
occurs, you must create a message for SAP support. To quickly restore data consistency on both sides, you must
resend any missing business documents after you restart the unavailable components.

Consistency Check Procedure
The following consistency check procedure applies to all SAP TM releases:
1. Locktheusers

You need to do this in case you need to perform a consistency check and the SAP TM system does not allow
any active processes. Lock all users except for the administrator, until you restore data consistency.

2. Check and end system activities
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Users who are already logged on must leave the system, and you must stop scheduled background jobs for
the duration of the consistency check. You can send messages to the relevant users. You must terminate
active tasks and jobs, or you must wait until they have finished.

3. Lock CIF queues

Depending on the object you need to check, you may also need to stop CIF queues so that data transfers are
not made from the OLTP systems for the duration of the consistency check. If you are using inbound queues,
you can stop the transfer by using report RSTRFCI1. If you are using outbound queues, you must use
transaction SMQ1 and program RSTRFCQL1 in the relevant OLTP systems to stop the transfer.

4. Select the objects to be checked and the scope of the check

You must identify the business documents that are affected by the system breakdown in the application log
or CIF queues.

5. Execute the consistency check
Correct inconsistencies
You use the tools provided to correct data inconsistencies. Alternatively, you can create a message for SAP
support.
7. Unlock the CIF queues
After the consistency checks, or when you have restored internal data consistency, you can restart the CIF
queues. If you are using inbound queues, use report RSTRFCQ3. If you are using outbound queues, you must
restart the queues using transaction SMQ1 and program RSTRFCQ3.
8. Release the background jobs that you stopped earlier
Known Problems
A heavy data load at the interface can cause the system to report inconsistencies that do not actually exist. This is
because the system cannot post the data that is being transferred fast enough.
In this case, you cannot correct an inconsistency by transferring the data again.
Use the queued remote function call (qRFC) monitor to check the relevant entry in the queue. Use the error
number specified to find a relevant SAP Note. If this procedure and the debugging of the relevant queue do not
produce any results, create a message for SAP support. Provide details about the queue name and all the relevant
logon data from your system.
OLTP and OLAP Systems
An OLTP system covers functions for sales and distribution, material and inventory management, controlling,
shop floor control, logistic execution, and so on.

An online analysis processing (OLAP) system provides accumulated historical data as a basis for analysis in SAP
TM. An example of such a system is SAP Business Information Warehouse (BW).

CUSTOMER
© Copyright 2015 SAP SE or an SAP affiliate company. SAP™ Transportation Management
22 All rights reserved. Monitoring of SAP Transportation Management



4 Management of SAP Technology

We provide you with an infrastructure to help your technical support consultants and system administrators
effectively manage all SAP components and complete all tasks related to technical administration and operation.

For more information about the underlying technology, see the Technical Operations Manual in SAP Library under
SAP NetWeaver.

4.1 Starting and Stopping

For the list of components required for each scenario, see Scenario/Component Matrix [page 10].

If a component does not start properly, see Troubleshooting [page 37] to analyze the problem.

Start and Stop Sequences and Tools

We recommend that you start the components in the following order. To stop, proceed in the reverse order.

Table 10: Start and Stop Sequences and Tools

Software Component Start and Stop Sequences and Tools

Sequence Tool Detailed Description

SAP Transportation Management

TM Server 1 STARTSAP / STOPSAP (Unix) Not applicable

SAPMMC (Windows)

J2EE Engine 2 Depending on the system landscape Required for Adobe
Document Services

SAPERP 6.0 3 STARTSAP / STOPSAP (Unix) Not applicable
SAPMMC (Windows)
SAP NetWeaver BI 7.0 Server 4 STARTSAP / STOPSAP (Unix) Not applicable

SAPMMC (Windows)

SAP NetWeaver Exchange 5 STARTSAP / STOPSAP (Unix) Not applicable

Infrastructure (XI) Server SAPMMC (Windows)

CIF (Plug-In) 6 Not applicable In SAP TM, CIF is only
used if SAP ERP is used
and the relevant master
datais transferred from
SAP ERP to SAP TM. Itis
not used to transfer
transactional data from
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Software Component Start and Stop Sequences and Tools

Sequence Tool Detailed Description
SAP Transportation Management

SAP ERP to SAP TM and
vice versa.

SAP SCM Optimizer 7 Not applicable Not applicable

Internet Graphics Server (IGS) 8 You can start/stop the Windows IGS by | Not applicable

using services. Choose |F Start »
Settings » Control Panel (or:
Administrative Tools) » Services » SAP
IGS (scroll down) ¥ Button: Start/Stop
Service 1

Even though SAP Xl and SAP SCM Optimizer can be started independently of all other components, we
recommend that you start and stop the components in a certain sequence.

For more information about STARTSAP/ STOPSAP and SAPMMC, see SAP Library for SAP NetWeaver at

help.sap.com/nw . In SAP Library for SAP NetWeaver 7.4, choose |r SAP NetWeaver » Administration
Information » Technical Operations for SAP NetWeaver 1.

Starting and Stopping CIF

e To start the CIF queues of your SAP TM system, use the following reports in SAP TM and all connected ERP
systems.

o For outbound queues, use report RSTRFCQ3.
Enter the following values:
© Parameter QNAME: CF*
O Parameter DEST: <Name of logical system>
©  Parameter FORCE: no entry required
© Parameter NO_ACT: no entry required
©  Forinbound queues, use report RSTRFCTI 3.
Enter the following values:
o0 Parameter QNAME: CF*
©  Parameter FORCE: no entry required
o Parameter MAXTLUW: no entry required
© Parameter NO_ACT: no entry required

To determine whether you are using inbound or outbound queues, call transaction CFC1 in the connected
SAP ERP systems and transaction /SAPAPO/C2 in the SAP TM system.

If you are using outbound queues, you only need to start the outbound queues. If you are using inbound
queues, inbound and outbound queues have to be started.

® Tostop the queues, use the following reports in the SAP TM system and all connected SAP ERP systems
according to the queue type you are using:

©  For outbound queues, use report RSTRFCQ1.

Enter the following values:
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o  Parameter QNAME: CF*
© Parameter DEST: <Name of Logical System of receiving system>
©  Parameter FORCE: no entry required

©  Forinbound queues, use report RSTRFCI 1. For parameter OQNAME, enter CE*. No entry is required for
parameter FORCE.

To determine whether you are using inbound or outbound queues, call transaction CFC1 in the connected
SAP ERP systems and transaction /sapap0o/cC2 in the SAP TM system.

If you are using outbound queues, you only need to stop the outbound queues. If you are using inbound
queues, inbound and outbound queues have to be stopped.

For more information, see SAP Note 505304 .

Starting and Stopping the J2EE Engine

If you want to print from SAP Transportation Management, you have to be able to start/stop the J2EE Engine.

Different procedures apply depending on your operating system and how you installed the J2EE Engine in your
system landscape.

For detailed documentation about starting and stopping the J2EE Engine, see the Technical Operations Manual
for the J2EE Engine.

The Technical Operations Manual for the J2EE Engine is part of the Technical Operations Manual for SAP
NetWeaver and can be found in SAP Library.

4.2 Software Configuration

This section explains which components or scenarios used by this application can be configured and which tools
are available for making adjustments. To avoid dumps caused by lack of available memory, enter 250MB as the

value for parameter abap/shared objects size MB.For moreinformation, see SAP note 1780851 .

Table 11: Component Configuration Tools

Configuration Tool(s) Detailed Description

SAP SCM Basis Not relevant No technical configuration data

SAPTM Not relevant No technical configuration (all technical
configuration that is required for
running SAP TM is part of SAP
NetWeaver)

4.3 Administration Tools

All SAP TM 9.3 components are technically based on SAP NetWeaver.

For more information, see SAP Library for SAP NetWeaver at help.sap.com/nw # . In SAP Library for SAP
NetWeaver 7.4, choose |» SAP NetWeaver » Administration Information » Technical Operations for SAP
NetWeaver 1.
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4.3.1 Administration Tools for SAP Transportation

Management 9.3

The following tools can be used for administration of the SAP TM 9.3 system:

Table 12: Administration Tools for SAP TM

Monitoring Object | Monitoring Monitor Monitoring Responsible Escalation
Transaction / Frequency Activity or Error Procedure
Tool Handling
Procedure
Evaluation of Transaction SLG1 | Daily Evaluate the Program Contact
Application Log application log in scheduling application
SAP management support

Transportation
Management

For more information about the administration tools for SAP TM 9.3, see SAP Transportation Management 9.3
Analysis Tools [page 15].

4.3.2 Administration Tools for SAP SCM Optimizer

The following tools can be used for administration of the SAP SCM Optimizer system.

Table 13: Administration Tools for SAP SCM Optimizer

Monitoring Object | Monitor Monitor Indicator or Error | Monitoring Responsibility
Transaction / Frequency Activity or Error
Tool Handling
Procedure
Optimizer server rcc_cust During installation, | Not applicable Maintain master Basis Support
settings or for data for
configuration optimization
changes to servers.
optimizer servers
RFC destinations | SM59 / During installation | Test connection Defining and System monitoring
for optimizers rcc_cust or after status to ensure all | checking optimizer | team and Basis
configuration is OK RFC destinations — | Support
changes can also be used to
check if optimizer
server is online

Transport of Configuration Settings

All configuration settings of SAP SCM Optimizer are stored on the application server. Standard ABAP transports
and Customizing settings can, therefore, be used to transport configuration settings.
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Customer Modifications

The different optimizers cannot be changed by the customer. If customer-specific changes have been approved
by SAP, they are incorporated into the standard optimizer engines. Therefore, no special version management is
required. For changes outside SAP SCM Optimizer (ABAP), the Workbench can be used.

Conflicts between customer-specific changes (ABAP) and SAP updates can be solved using the Workbench.

4.3.3 Administration Tools for SAP Business Information

Warehouse
Table 14

Transaction/Tool Detailed Description

SMQ1 Use this transaction to monitor whether the delta data is
filled into the outbound queue.

SMQR Use this transaction to check the status of the scheduler, and
to stop or start it.

BWA7 Use this transaction to monitor active DataSources and
regenerate an extraction report.
You can also monitor the BW Adapter delta queues.

BWAS Use this transaction to activate BW Adapter metadata in
customer systems.

RSA3 Use this transaction to check and simulate the data
extraction

4.4 Backup and Restore

You need to back up your system landscape regularly to ensure that you can restore and recover it in case of
failure.

The backup and restore strategy for the application consists of two parts:
® Backup and restore coverage for each component
® (Cross-system data dependencies and handling

The backup and restore strategy for your system landscape should not only consider SAP systems but should
also be embedded in the overall business requirements and incorporate your company's entire process flow.

In addition, the backup and restore strategy must cover disaster recovery processes, such as the loss of a data
center through fire. It is most important in this context that you ensure that backup devices are not lost together
with normal data storage (separation of storage locations).
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Table 15

Component Category Application Data Type Backup Method for
Application Data

SAP TM Server Original and Replicated Database and log backup

File system backup (full or
incremental)

SAP SCM Optimizer Il N/A N/A
SAP IGS Il N/A N/A
SAP Xl Server Xl Original and Replicated Database and log backup

File system backup (full or

incremental)

441 SAP TM Server / SAP SCM Optimizer

The SAP TM Server is a component that receives data from other systems, such as SAP ERP, and is also the
leading system for some application data of its own. The SAP TM system is based on SAP Web Application Server.

Inan SAP TM scenario, dependencies may exist to multiple other components such as SAP ERP, which are based
on SAP Web Application Server as well.

In the case of a complete restore of the SAP TM database without data loss, there is no impact on external data
consistency with other systems. If data loss occurs, see section 5 (Managing Incomplete Recovery) of the best-
practice document Backup and Restore for SAP Business Suite. This document is available on SAP Service

Marketplace at |F service.sap.com/alm-methodologies # » Best-Practice Documents » Backup and Restore for
SAP System Landscapes 1.

For more information about backup, restore, and recovery of the SAP TM Server and SAP SCM Optimizer
including online backup and back up of the scenarios, also see the best-practice document Backup and Restore
for SAP Business Suite.

4.4.2 SAP Internet Graphics Server

Classification

The SAP IGS does not contain any persistent application data. Therefore, you only need to back up the IGS itself
and the configuration files.

Backup

Depending on where the IGS is installed, you have the following options for backup and recovery:

1) Installation on Web AS

If you have installed the IGS on the Web Application Server, you have two options for backup and recovery:

1.  Make a backup of all files of the IGS installation using operating system tools. You can recover the IGS by
using your backup.
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2. Make a backup of all files in the con £ directory of the IGS installation. For a recovery, reinstall the IGS and
copy all files from the back-up conf directory to the conf directory.

2) Standalone Installation on Microsoft Windows Server

If you have installed the IGS on a standalone Microsoft Windows server, you have two options for backup and

recovery:

1. Make a backup of all files of the IGS installation. For a recovery, restore the IGS files and restart the IGS
service in Microsoft Windows using command igswdserv -i inthe bin directory of the installation
directory.

2. Make a backup of all files in the directory con £ of the IGS installation. For a recovery, reinstall the IGS and
copy all files from the back-up conf directory to the conf directory.

Restore

For more information, see the best practice documentation for backing up and restoring SAP Business Suite at
service.sap.com/bp-roadmap # .

4.4.3 SAP Xl Server

For the backup and recovery concept for all other SAP NetWeaver components mentioned in this guide, including
the SAP Exchange Infrastructure (XI) Server, see the Technical Operations Manual for SAP NetWeaver in SAP
Library.

4.5 Periodic Tasks

In addition to the standard jobs mentioned in the Technical Operations Manual for SAP NetWeaver (in SAP Library
under SAP NetWeaver), you must schedule SAP TM-specific jobs in your SAP system. All jobs, unless otherwise
specified, should be run at times of minimal system activity, so as not to affect performance or otherwise disrupt
your daily operations. All jobs can be restarted. There are no dependencies between the jobs.

45.1 Scheduled Periodic Tasks

This section describes all tasks that can be automated and that are required to run periodically to keep the
application running smoothly. Such tasks may be required on component level and are, therefore, relevant in each
scenario that uses the component. You can find the mapping in the Scenario/Component Matrix [page 10]
section. Other tasks may be relevant for certain business scenarios only. It is important that you monitor the
successful execution of these tasks on a regular basis.

Table 16
Standard / Housekeeping Jobs for SAP Transportation Management
‘ Program Name/Task ‘ Recommended Frequency ‘ Detailed Description ‘
CUSTOMER
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I ———
Standard / Housekeeping Jobs for SAP Transportation Management

Report POWL_WLOAD Once, nightly All user query (work lists) results within
a POWL context are cached into an
internal cluster table. Every time a user
chooses the refresh link in the worklist,
the results of the feeder class method
GET_OBJECTS are saved to this cache.
The POWL always reads the cache
regardless of the Sync setting in the
type repository or query definition.

This cache enables the administrator to
create a scheduled worklist using the
POWL_ WLOAD report.

Report SBAL DELETE Occasionally, for example, monthly As described in SAP Note 195157 A,

using the application log occupies
storage space on the database. To free
the database of outdated entries, we
recommend that you execute report
SBAL DELETE periodically.

Recommendation: coordinate with
archiving cycles.

Report /SAPAPO/ Monthly Master data: Deletes products with
DELETE PRODUCTS deletion flag

Report /SAPAPO/ Yearly Master data: Deletes locations with
DELETE LOCATIONS deletion flag

Report /SCMB/ Weekly/monthly Deletes alerts older than x days

ALEN ALERT DELETE

Report /SCMTMS/PLN_EXP DELETE | Daily Deletes Optimizer Explanation logs
older than x days

Report /SCMTMS/ Every 10 minutes Executes re-run of actions for locked

PROCESS_TRIGGER _BGD objects; see consulting note 1747234 e
for details of trigger handling

Table 17

Standard / Housekeeping Jobs for TM Tendering

Program Name/Task Recommended Frequency Detailed Description

Report /SCMTMS / Every 5 to 120 minutes, depending on Processes incoming freight quotations

TEND CONT_PROCESS the minimum response times for and continues the tendering process
carriers in tendering after a freight quotation has been

received or after the maximum
response time for a freight request for
quotation is over.
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Standard / Housekeeping Jobs for TM Tendering

Report /SCMTMS /
TEND PROCESS INBOX

Same frequency as report / SCMTMS /
TEND CONT_ PROCESS.We
recommend that you run this report
immediately before /SCMTMS /
TEND_ CONT_PROCESS.

Converts freight quotations that have
been received from carriers by e-mail so
that the quotations can be processed by
report /SCMTMS /

TEND_CONT PROCESS. This reportis
not required if receiving freight
quotations by e-mail is not enabled.

Report /SCMTMS /
TEND NOTIFICATION MATIL

Hourly/daily

Instead of notifying a carrier
immediately about tendering events by
e-mail, the system administrator can
choose to send collective e-mails to
carriers periodically. Schedule this
report to create these notification e-
mails.

Table 18

Standard / Housekeeping Jobs for SAP SCM Optimizer

Program Name/Task

Recommended Frequency

Detailed Description

Report RCC_CLEANUP Daily This report should be run daily to delete

Transaction RCC_CUST all log entries made by RCC and all
external files on remote engine servers
for which the log deletion time
parameteris setin rcc_cust.

Report BRCONNECT Daily Calculates Bl-relevant optimizer
statistics (for Oracle); see SAP Notes
129252 A and 421795 A

Table 19

Standard / Housekeeping Jobs for SAP TM Collaboration Portal

Program Name/Task

Recommended Frequency

Detailed Description

Report /SCMTMS / Daily This report should be scheduled daily in

UPLOAD RFQ RESPONSE order to import carrier responses
uploaded through the collaboration
portal.

Report /SCMTMS / Weekly/Monthly There can be situations where your

DEL_DRAFT DISP CASE

SAP™ Transportation Management
M t of SAP Technology

service provider creates a dispute case
on the collaboration portal, but does not
submit the dispute case. For example,
the service provider may close the
browser screen before they submit the
dispute. In such a situation, the system
creates a draft dispute case that is
incomplete. To delete these draft
dispute cases from the system, you
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I ———
Standard / Housekeeping Jobs for SAP TM Collaboration Portal

must run the program /SCMTMS /

DEL DRAFT DISP CASE.We
recommend that you run this program
at regular intervals to keep your system
clean.

4.5.2 Required Manual Periodic Tasks

This section describes all manual tasks that must be run periodically to keep the application running smoothly. A
manual task must be executed by a user, whereas the scheduled tasks listed above can be automated using a task
scheduler program. Such tasks may be required on component level and are, therefore, relevant in each scenario
that uses the component. You can find the mapping in the Scenario/Component Matrix [page 10] section. Other
tasks may be relevant for certain business scenarios only. It is important that you monitor the successful
execution of these tasks on a regular basis.

4.6 Load Balancing

SAP TM 9.3 uses standard functions for logon and load balancing available in SAP Web Application Server 7.4,
and does not require an application-specific tool. For more information, see the Technical Operations Manual for
SAP NetWeaver.

For more information about network load balancing, see sdn.sap.com/irj/sdn/ha .

For more information, see SAP Library for SAP NetWeaver on SAP Help Portal at help.sap.com/nw . In SAP
Library for 7.4, choose [k SAP NetWeaver » Administration Information » Technical Operations for SAP
NetWeaver 1.

4.7 Management of Outdated Technical Data

Application Copy
For a homogeneous system copy of all the components for SAP Transportation Management , the standard
procedures of SAP NetWeaver apply.

For more information, see the System Copy documentation in Technical Operations Manual for SAP NetWeaver in
SAP Library.

Heterogeneous system copies are currently supported on request and on a project basis. For more details and
forms, see service.sap.com/osdbmigration # .

1 Note

A client copy from one system to another with a different operating system or database is not an alternative to
a complete heterogeneous migration. For example, client copies do not ensure that all repository changes are
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transferred to the new system. Therefore, if you want to change your database or application server platform, a
heterogeneous system copy is the only procedure that ensures full data replication into the new system.

4.8 Scenario Administration Concept

User Management

SAP TM 9.3 uses standard functions for user management available in SAP Web Application Server 7.4 and does
not require an application-specific tool. For more information, see the Technical Operations Manual for SAP
NetWeaver..

For more information about user management in SAP TM, see also the SAP TM Security Guide.

Printing

SAP Transportation Management uses standard functions of SAP NetWeaver for printing and does not require an
application-specific tool. For more information, see SAP Library for SAP NetWeaver on SAP Help Portal at
help.sap.com/nw . In SAP Library for SAP NetWeaver 7.4, choose [» SAP NetWeaver » Administration

Information » Technical Operations for SAP NetWeaver » Administration of Application Server ABAP » SAP
Printing Guide 1.

Quality Management and Test Management

You can use the SAP NetWeaver Development Infrastructure to learn about the various possibilities to test your
software changes.
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5 High Availability

SAP TM 9.3 uses standard functions for high availability in SAP Web Application Server 7.4 and does not require
an application-specific tool. For more information, see SAP Library for SAP NetWeaver on SAP Help Portal at

help.sap.com/nw # . In SAP Library for SAP NetWeaver 7.4, choose |» SAP NetWeaver: Function-Oriented View »
Solution Life Cycle Management » SAP High Availability 3.

51 SAP SCM Optimizer

High availability of SAP SCM Optimizer can be achieved by installing the optimizer programs on several servers.
Optimizer runs can be distributed to several machines during normal productive use to provide load balancing.

The high availability concept cannot restore the actual state of an aborted optimizer run — the optimizer run has to
be repeated completely — but it can ensure immediate availability of the optimizer software on a backup location.

For more information, see the SAP SCM Optimizer Installation Guide, which is available on SAP Service

Marketplace at |» service.sap.com/instguides i » SAP Business Suite Applications » SAP Transportation
Management » SAP SCM Optimizer 1.

1 Note
There is no need to use cluster software.
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6 Software Change Management

Software Change Management standardizes and automates software distribution, maintenance, and testing
procedures for complex software landscapes and multiple software development platforms. These functions
support your project teams, development teams, and application support teams.

The goal of Software Change Management is to establish consistent, solution-wide change management that
allows for specific maintenance procedures, global rollouts (including localizations), and open integration with
third-party products.

This section provides additional information about the most important software components for SAP
Transportation Management.

The following topics are covered:

® Transport and Change Management — Enable and secure the distribution of software changes from the
development environment to the quality assurance and production environment.

® Development Request and Development Release Management — Enable customer-specific maintenance
procedures and open integration with third-party products.

® Template Management — Enables and secures the rollout of global templates, including localizations.

® Quality Management and Test Management — Reduce the time, cost, and risk associated with software
changes.

® Support Packages and SAP Notes Implementation — Provide standardized software distribution and
maintenance procedures.

® Release and Upgrade Management — Reduces the time, cost, and risk associated with upgrades.

6.1 Transport and Change Management

SAP TM 9.3 uses standard functions for transport and change management issues in SAP Web Application Server

7.4 and does not require application-specific tools or procedures.

For more information, see SAP Library for SAP NetWeaver on SAP Help Portal at help.sap.com/nw #% . In SAP

Library for SAP NetWeaver 7.4, choose [ SAP NetWeaver » Administration Information » Technical Operations for

SAP NetWeaver » Administration of Application Server ABAP » Change and Transport System 1.

6.2 Development Requests and Development Release
Management

SAP TM 9.3 uses standard functions for development request and development release management issues in
SAP Web Application Server 7.4 and does not require application-specific tools or procedures.

For more information, see SAP Library for SAP NetWeaver at help.sap.com/nw # . In SAP Library for SAP
NetWeaver 7.4, choose |» SAP NetWeaver » Administration Information » Technical Operations for SAP
NetWeaver 1.
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6.3 Template Management

You can configure Customizing settings by using Business Configuration Sets (BC sets). For more information
about BC sets, see SAP Library under Business Configuration Sets (BC-CUS).

6.4 Support Packages and Patch Implementation

SAP TM 9.3 uses standard functions for software maintenance in SAP Web Application Server 7.4 and does not
require application-specific tools or procedures.

For more information, see SAP Library for SAP NetWeaver on SAP Help Portal at help.sap.com/nw . In SAP
Library for SAP NetWeaver 7.4, choose [ SAP NetWeaver » Administration Information » Technical Operations for
SAP NetWeaver » Administration of the Application Server ABAP » AS ABAP (Application Server for ABAP) 1.

For more information about the implementation of Support Packages as well as possible side effects, see

| service.sap.com/patches # » SAP Support Packages in Detail 1.

SAP TM 9.3 Recommendations

We recommend implementing Support Package Stacks (SP Stacks), which are sets of Support Packages and
patches for the respective product version that must be used in the given combination. The technology for
applying Support Packages and patches will not change.

For more information about the availability of SP Stacks for SAP TM 9.3, see SAP Service Marketplace at
service.sap.com/sp-stacks # .

Read the corresponding Release and Information Notes (RIN) before you apply any Support Packages or Patches
of the selected SP Stack.

The RIN and Support Packages for SAP TM 9.3 are available on SAP Service Marketplace at service.sap.com/
patches # . Use the search function to find the maintenance product for SAP TM 9.3.

CUSTOMER
© Copyright 2015 SAP SE or an SAP affiliate company. SAP™ Transportation Management
36 All rights reserved. Software Change Management


http://help.sap.com/disclaimer?site=http%3A%2F%2Fhelp.sap.com%2Fnw
http://help.sap.com/disclaimer?site=http%3A%2F%2Fservice.sap.com%2Fpatches
http://help.sap.com/disclaimer?site=http%3A%2F%2Fservice.sap.com%2Fsp-stacks
http://help.sap.com/disclaimer?site=http%3A%2F%2Fservice.sap.com%2Fpatches
http://help.sap.com/disclaimer?site=http%3A%2F%2Fservice.sap.com%2Fpatches

7 Troubleshooting

SAP TM 9.3 uses standard functions for troubleshooting in SAP Web Application Server 7.4 and does not require
application-specific tools or procedures. For more information, see SAP Library for SAP NetWeaver on SAP Help
Portal at help.sap.com/nw e . In SAP Library for SAP NetWeaver 7.4, choose |» SAP NetWeaver » Administration
Information » Technical Operations for SAP NetWeaver » Administration of Application Server ABAP » Monitoring
and Administration Tools for Application Server ABAP 1.

In addition, see the troubleshooting notes section in this document.

CUSTOMER
SAP™ Transportation Management © Copyright 2015 SAP SE or an SAP affiliate company.
Troubleshooting All rights reserved. 37


http://help.sap.com/disclaimer?site=http%3A%2F%2Fhelp.sap.com%2Fnw

8 Support Desk Management

Support Desk Management enables you to set up an efficient internal support desk for your support organization
that seamlessly integrates your end users, internal support employees, partners, and SAP Active Global Support
specialists with an efficient problem resolution procedure.

For support desk management, you need the methodology, management procedures, and tools infrastructure to
run your internal support organization efficiently.

8.1 Remote Support Setup

For information about remote support setup, see SAP Service Marketplace at service.sap.com/access-support
.

The read-only support role for SAP TM 9.3 is /SCMTMS/DISPLAY.

8.2 Problem Message Handover

For information about processing internal support messages and forwarding them to SAP, see SAP Library for

SAP Solution Manager on SAP Help Portal at help.sap.com/solutionmanager . In SAP Library for SAP Solution
Manager 7.0, choose |» SAP Solution Manager » Incident Management » Service Desk 1.

For sending problem messages/tickets to SAP, choose the appropriate component (or subcomponent) name
from the SAP component hierarchy.

The correct component for SAP TM 9.3 messages is TM.

For information about safeguarding, see service.sap.com/safeguarding .
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9 Services for SAP Solutions

For an overview of all services and support provided by SAP, see SAP Service Marketplace at service.sap.com/
servicesmap # .
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A Appendix

Al

Categories of System Components for Backup and

Restore
Table 20
Categories of Category Properties Suggested Methods for
System Backup and Restore
Components
| Only software, no configuration | ®  No backup, new BDOC modeler
or application data installation in case of a
recovery
® |nitial software backup
after installation and
upgrade
®  Backup of log files
Il Only software and configuration | ®  Backup after changes have | SAP Gateway

information; no application data

been applied

®  No backup, new
installation in case of a
recovery

®  Backup of log files

Comm. Station
SAP Business
Connector

SAP IPC (2.0C)

Only replicated application data;

replication time is sufficiently
small for a recovery

Data:
®  No data backup needed

®  Backup of software,
configuration, and log files

SAP IMS/Search
Engine *
SAP IPC (2.0B) *

Webserver *

SAPITS
IV Only replicated application data; | Data: SAP IMS/Search
backup recommended because | o  Application-specific file Engine *
re|:t>I|cat|on tldmbe is ’;);’\I/Iosng; data system backup Webserver *
not managed by a e  Multiple instances
®  Backup of software,
configuration, and log files
Y Only replicated application data; | Data: SAP IPC (2.0B) *
backup recommended because | o  Database and log backup | Catalog Server
lication time is too long; dat S
replication time is too long; data | Multiple instances
managed by a DBMS
®  Backup of software,
configuration, and log files
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Categories of
System

Components

Category Properties

Suggested Methods for
Backup and Restore

system); data consistency
with other systems must
be considered

®  Backup of software,
configuration, and log files

i Original application data; Data: Webserver *
standalone system; data not e Application-specific file
managed by a DBMS system backup
®  Backup of software,
configuration, and log files
VII Original application data; Data:
standalone system; data e Database and log backup
managed by a DBMS; not based ¢ Backup of software
on SAP WebAS _ _ .
configuration, and log files
VIII Original application data; Data: Standalone SAP ERP
standalone system based on e Database and log backup,
SAP WebAS application log backup
(such as job logs in file
system)
®  Backup of software,
configuration, and log files
IX Original application data; data Data:
exchange with other systems; e Application-specific file
data not managed by a DBMS system backup, data
consistency with other
systems must be
considered
e  Backup of software,
configuration, and log files
X Original application data; data Data: SAP liveCache
exchange with other systems; e Database and log backup; | SAP Mobile
data managed by a DBMS; not data consistency with Workbench
based on SAP WebAS other systems must be
considered
®  Backup of software,
configuration, and log files
Xl Original application data; data Data: SAP ERP
exchange with other systems e Database and log backup, | SAP CRM
based on SAP WebAS application log backup SAP APO
(such as job logs in file SAP BW
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A.2 Related Guides

For more information about installation and configuration procedures, see the Master Guide for SAP TM 9.3 at
|p service.sap.com/instguides # » SAP Business Suite Applications » SAP TM » Using SAP TM 9.3 1.

A.3 Related Information

The following table contains links to information relating to the Application Operations Guide.

Table 21
Master Guide, Installation Guide, and I» service.sap.com/instguides # 3
Upgrade Master Guide
Related SAP Notes |b service.sap.com/notes # 3
Released Platforms |b service.sap.com/platforms # 3
Network Security Ik service.sap.com/securityguide # 3
Technical Infrastructure |b service.sap.com/installNW70 # 3
SAP Solution Manager |k service.sap.com/solutionmanager # 3
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